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SUMMARY

This protocol describes how to image time and spatially resolved time lapses of
Drosophila air sac primordium (ASP) cytonemes in ex vivo cultures of wing imaginal
discs. It describes how to manually measure the length of cytonemes using custom-
madeFIJI/ImageJ tools, and toanalyzedatausingR/R-Studiospipeline. It can alsobe
used for studies of cell division, organelle localization, and protein trafficking as well
as other cellularmaterials that can be fluorescently tagged and imagedwithminimal
phototoxicity.

BEFORE YOU BEGIN

3D printing ring device

Timing: 1–2 h

1. 3D print the inner and outer rings (Figures 1A and 1B) with Polylactic Acid (PLA) filaments. with a

3D Printer using the .stl files available for download.Troubleshooting 1

Note: Recommended printers based on our experience: Ultimaker 3, LulzBot Mini 3D Printer).

2. Assemble the rings together with a 13 mm diameter hydrophilic Membrane Filter (Millipore

HAWP01300)

a. Assembly order from bottom up: inner ring, membrane, outer ring (Figure 1B).

b. Push the rings tight to stretch the membrane.

c. After the ring is assembled, use a sterile pipette tip to apply force in the middle of the mem-

brane to release the hard stretching tension and form a small concave cavity for the wing disc

(Figure 1C).

d. Use one membrane assembly per culture.

Note: After use, remove membrane, rinse rings with 70% ethanol, store in 70% ethanol.

Alternatives: a small disc of approximately 13 mm diameter cut from larger hydrophilic mem-

brane filter.

Alternative method to printing 3D rings

Timing: 5 min

3. Cut 4 pieces of double-sided tape, each approximately 2 3 7 mm.
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4. Combine two-layers of tape and space each tape sandwich 3–4 mm apart on the glass surface of a

35 mm Glass Button m-Dish (Ibidi, Cat#: 81158) (Figure 1D-Step 1)

Note: the sample will be placed in the space between pieces of tape, followed by membrane

placed on top of sample and secured to the assembly by the tape (Figure 1D-Step 2)

Drosophila genetics and selection

Timing: 2 weeks

5. Normal Drosophila husbandry.

a. For observation of ASP cytonemes, stocks contain either btl-Gal4 UAS-CD4:GFP or btl-LHG

LexOp-CD4:GFP

b. For studies of protein overexpression or RNAi knock-down, lines contain either btl-Gal4 UAS-

CD4:GFP or ap-Gal4 UAS-CD4:GFP.

6. Wing discs are dissected from late stage (wandering) third instar larvae.

Media preparation alternatives

Timing: 30–60 min

7. Medium #1: Grace’s medium (Gibco; Cat#:12300027) supplemented with 5 mM BisTris (Dye

et al., 2017)

a. Dissolve media powder designated for 1 liter in approximately 750 mL water.

b. Add 1.05 g BisTris (Sigma; Cat#: 9754-25G) and stir to dissolve.

c. Slowly adjust the pH to 6.6–6.7.

Note: slow addition avoids formation of precipitate.

d. Bring volume to 1 L

Figure 1. 3D printed rings set up for wing imaginal disc ex vivo culture

(A and B) The 3D inner and outer rings were drawn (A - measurements in mm) and designed using Onshape (B).

(C) After assembly of the rings with filter membrane the ring in placed on top of the wing disc sample inside the culture dish and media is added (C).

(D and E) Alternatively double-sided tape can be used as spacer for the filter membrane (D) and assembled over the cover glass in the bottom of the dish

with the sample (E), according to steps 1–6 in step-by-step method details.
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e. Filter media through a 0.22 mm filter (Millipore; Cat#: S2GVU05RE) in a cell culture hood.

f. Supplement with 2%–5% FBS.

Note: Media can be stored at 4�C for no longer than a month. Penicillin (64.7 mg/mL) and

Streptomycin (100 mg/mL) may be added.

g. For use, place an adequate volume in a test tube and bring to room temperature.

8. Medium #2: Ready to use Schneider’s media (Gibco; Cat#:21720024) supplemented with 2%–5%

FBS

a. Open new bottle of Schneider’s media in a cell culture hood, add 2%–5% FBS.

Note: Media can be stored at 4�C for no longer than a month. Penicillin (64.7 mg/mL) and

Streptomycin (100 mg/mL) may be added.

b. For use, place an adequate volume in a test tube and bring to room temperature.

Installation of FIJI/ImageJ Cytoneme Analysis Tool

Timing: 5 min

9. Download, Install FIJI from: https://imagej.net/downloads

10. Download the Cytoneme Analysis Tool file from the GitHub repository

a. Open GitHub link: https://github.com/gbarbosabio/Cytoneme_dynamics

b. Click the green ‘‘Code’’ button and click the ‘‘Download ZIP’’ button.

c. Download compressed file: ‘‘Cytoneme_dynamics-main’’. Decompress downloaded file.

d. Open FIJI, click, Plugin>Install. (Figure 2 – step 1)

i. Find the decompressed folder ‘‘Cytoneme_dynamics-main’’.

ii. Click file ‘‘Cytoneme.ijm’’ to Open.

iii. In the window ‘‘Save Plugin, Macro or Script’’, move up one level to the folder ‘‘Fiji.App’’,

click on the folder ‘‘macros’’, then ‘‘toolsets’’, and finally click ‘‘Save’’. To complete instal-

lation, close FIJI and reopen.

11. To activate the Cytoneme analysis tools in the toolbar, click the button: ‘‘More Tools’’ ‘‘>>’’ and

‘‘Cytonemes’’ (Figure 2 – step 2). Three new buttons should appear on the FIJI Tools Bar: ‘‘Start

CytoID Tool’’, ‘‘Cytoneme Dynamic Tool’’ and ‘‘Cytoneme Static Tool’’ (Figure 2).

Figure 2. Installation of cytoneme analysis tool into FIJI

Installation of the tool into FIJI by click ‘‘Plugin>Install.’’ then choosing the ‘‘Cytoneme.ijm’’ file inside the ‘‘Cytoneme-Analysis-main’’ folder (step 1).

Activation of Cytoneme Analysis Tool in FIJI tool bar by clicking in ‘‘More tools>Cytotneme’’ (step 2) according to steps 9–11 in before you begin.
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Note: For a complete video tutorial, see Method.Video.S1 at README page of the GitHub

repository.

R/RStudios analysis pipeline preparation

Timing: 5 min

12. Open R link: https://cran.r-project.org/mirrors.html.

13. Download R one of the repository institutional links and install

14. Download RStudios from: https://www.rstudio.com/ and install

15. Open RStudios, go to File>Open File

a. Find the decompressed folder ‘‘Cytoneme_dynamics-main’’

b. Open file ‘‘Cytoneme_filipodia_dynamics_pipeline_ALLinONE’’

KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER

Deposited data

Wild Type_Sample_1 timelapse max z-projection This paper https://github.com/gbarbosabio/Cytoneme_dynamics/
tree/main/Image_sample

‘‘Wild type_Sample_1’’ data frame This paper https://github.com/gbarbosabio/Cytoneme_dynamics/
tree/main/Experiment_data_sample/WT

‘‘Wild type_Sample_2’’ data frame This paper https://github.com/gbarbosabio/Cytoneme_dynamics/
tree/main/Experiment_data_sample/WT

‘‘apGAL4-botvRNAi_Sample_1’’ data frame This paper https://github.com/gbarbosabio/Cytoneme_dynamics/
tree/main/Experiment_data_sample/ApGAL4-botvRNAi

‘‘apGAL4-botvRNAi_Sample_2’’ data frame This paper https://github.com/gbarbosabio/Cytoneme_dynamics/
tree/main/Experiment_data_sample/ApGAL4-botvRNAi

Experimental models: Organisms/strains

btl-Gal4, UAS-CD4:GFP/CyO,wp Roy et al. (2014) N/A

ap-Gal4/CyO,wp; btl-LHG,LexOp-CD4:GFP/TM6b Roy et al. (2014) N/A

UAS-botvRNAi Bloomington Drosophila
Stock Center

BDSC#: 61257

Software and algorithms

FIJI Schindelin et al. (2012) https://imagej.net/downloads

Cytoneme analysis tool This paper https://github.com/gbarbosabio/Cytoneme_dynamics

R Bunn and Korpela (2000) https://cran.r-project.org/mirrors.html

RStudios N/A https://www.rstudio.com/

ggplot Wickham (2009) Install with RStudio

‘‘Cytoneme_filipodia_dynamics_pipeline_
ALLinONE’’

This paper https://github.com/gbarbosabio/Cytoneme_dynamics

Other

Ultimaker 3 3D Printer Ultimaker N/A

13 mm diameter, MCE membrane, hydrophilic MilliporeSigma HAWP01300

m-Dish 35 mm, high Glass Button Ibidi Cat.No:81158

Grace’s Insect Medium, unsupplemented, powder Gibco – Thermo Fisher
Scientific

Cat.No:12300027

Stericup Quick Release Durapore 0.22 mm PVDF
500mL

MilliporeSigma Cat#:S2GVU05RE

FBS UCSF cell culture Cat#:97068-085

Schneider’s medium Gibco – Thermo Fisher
Scientific

Cat.No:21720024

BisTris Sigma-Aldrich Cat#: 9754-25G

Cell Strainer VWR Cat#: 76327-098

Dissecting forceps VWR Cat#: 82027-408

Confocal Laser Scanning Microscope FV3000 Olympus N/A
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STEP-BY-STEP METHOD DETAILS

Wing imaginal disc ex vivo culture

Timing: 15–30 min

With these steps you will dissect and mount the sample in the culture dish for imaging.

Note: Practice the dissection if you are not familiar with wing disc dissection for ASP observa-

tion - cytonemes are dynamic and sensitive to perturbation.

1. Clean all dissection tools with 70% ethanol and allow ethanol to fully evaporate.

2. Prepare the culture dish to receive the sample (Figure 1).

Note: Keep the dish covered with a lid when possible.

a. For a 3D ring with membrane option, assemble on a clean surface.

b. For options with membrane and tape spacers, prepare the tape spacers attached to the glass

of the 35 mm m-Dish (Figure 1D – step 1) and have the membrane ready for placement.

3. Prepare wandering stage larvae for dissection

a. Select larvae of the desired genotype.

b. Place larvae in a cell strainer (VWR; Cat#: 76327-098), rinse with 70% ethanol, rinse with sterile

water.

4. Transfer larvae to a dissection dish containing sterile culture media, dissect under a stereoscope

(Figure 3A).

a. Use two fine forceps (VWR; Cat#: 82027-408) to cut larvae in half, preserving the anterior which

contains the mouth hocks (Figure 3A – step 1).

b. Grab the mouth hooks with one forceps and gently push the larval body wall with the second

forceps towards the mouth hooks, flipping the cuticle inside-out (Figure 3A – step 2).

c. Carefully remove fat body, gut, ventral nerve cord (VNC), leaving imaginal discs and trachea

(Figure 3A – step 3).

d. Place 20 mL of media in the middle of the m-Dish and transfer the cleaned sample to it (Figure 3B).

e. Dissect the two wing discs from the carcass, while preserving as much attached trachea as

possible.

Note: Preparations should include dorsal trunk (DT) and lateral trunk (LT) anterior and poste-

rior to wing disc, as well as the stalk (most dorsal tip) of the wing disc. Haltere and leg discs

linked to the wing disc may be included.

f. Place the wing disc with the side attached to trachea (columnar epithelial cells) oriented down,

in contact with the glass surface. Troubleshooting 2

g. Discard other larval material.

5. Carefully place the pre-assembled 3D ring on top of the 20 mL drop of medium OR place the

membrane over the drop and attach to the double-sided tape spacers. Troubleshooting 3

6. Carefully add 2 mL of media to the m-Dish and close the lid (Figure 1C).

CRITICAL: The ASP is sensitive to touch and turbulence; it is important to dissect the wing

disc quickly without touching or pinching it. Multiple discs may be added to the same dish

to increase the chance of having a properly oriented, undamaged sample.
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Imaging cytonemes with a confocal microscope

Timing: 1–5 h

In this step, images will be captured with a point scanning or spinning disc confocal microscope. To

observe cytoneme dynamics for up to 4–5 h, the microscope must be equipped for fast acquisition

and low laser intensity to minimize phototoxicity. Troubleshooting 4

7. Place the 35 mm m-Dish containing the sample on the stage of an inverted microscope

8. Locate the wing disc and choose the appropriate objective.

a. In this protocol we report images made with an Olympus FV3000 inverted point scanning

confocal microscope using the oil immersion objective UPLFLN40XO.

Note: This protocol is suitable for a variety of inverted confocal microscopes and objectives.

9. Select appropriate laser (i.e.: 488 nm for GFP excitation).

10. Use low laser power to minimize phototoxicity

Figure 3. Dissection scheme of the wing imaginal disc for ASP cytoneme visualization ex vivo

(A) The clean larvae are placed in a dissecting dish containing media and cut in half then the cuticle is flipped inside-

out and finally the sample is cleaned by removing unwanted tissues (A). The sample is transferred to a 20 mL drop of

media in the culture dish where the indicated tracheas are cut (dashed lines) and the wing imaginal disc is released.

(B) Then place the tissue with the trachea facing the glass bottom, and the filter membrane will gently keep the tissue

in place (B) according to steps 1–6 in step-by-step method details.
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11. Use maximum detection voltage gain such that structures of ASP cells remain detectable, and

background levels are not excessive.

12. Adjust zoom if necessary.

13. Choose the lowest pixel resolution that allows visualization of cytonemes (i.e.: 0.200 mm/pixel).

14. Set z-stack acquisition to image the entire depth of ASP.

15. Crop to area of interest

a. Include ample space around ASP because the tissue may move during imaging and

cytonemes will extend at least 40 mm from the ASP surface

Note: Acquisition time for each z-stack should be less than one minute to resolve cytoneme

movement (i.e.: 60 stacks with 0.5 mm spacing imaged at 1 stack/min.). Size of cropped

area or depth of the z-stack can be reduced if acquisition takes longer than one minute.

16. Set total acquisition time for total period of viewing.

Note: The total acquisition time interval must be greater than or equal to the sum of all z-stack

acquisition times.

EXPECTED OUTCOMES

A successful experiment will generate multiple z-stacks (either single channel or multi-channel) for

several time points. The expected result is a set of images of the ASP with many cytonemes extend-

ing and retracting (troubleshooting 5). One or more cell divisions (troubleshooting 6) are likely and

are an indication of tissue viability (Methods video S1).

QUANTIFICATION AND STATISTICAL ANALYSIS

Cytoneme length measurement using FIJI/ImageJ Cytoneme Analysis Tool

Timing: 4 h

This application was created to measure cytoneme lengths in a semi-automated way. Length

measurements are obtained from traces drawn over the cytonemes on max z-projections images.

Note: For a complete video tutorial of the following steps, see Method.Video.S2 at README

page of the GitHub repository

1. Open image in FIJI with File>Open.

2. Create a max z-projection of the image with Image>Stacks>Z Project.

3. Choose the Start and Final Z Slice and select Max Projection in Projection Type.

a. Adjust with Image>Adjust>Brightness and Contrast pulldown. Adjust Image>Lookup Table,

to select grayscale and invert background to white.

b. Save max intensity z-projection file

c. Close original Z-Stack file

4. Activate Cytoneme Analysis Tool in the tool bar (see step 13).

5. Click the first button ‘‘Start CytoID Tool’’, click the image.

6. The ‘‘Welcome.’’ window will open and the following information must be completed and/or

confirmed

a. ‘‘Group name’’ – the name of the experimental group

b. ‘‘Sample number’’ – choose a number to identify the sample (e.g.,.: 1, 2, 3, .)

c. ‘‘Time Calibration’’ –the number of HOURS, MIN or SEC per frame in the time lapse

i. Tip: time units cannot be mixed; designate as decimal fractions (e.g., 1.5 min or 90 s)

d. ‘‘Pixel calibration’’ - designate how many units each pixel represents in the image.

e. ‘‘Pixel unit’’ – choose the space unit used in the image (‘‘cm’’, ‘‘mm’’, ‘‘mm’, ‘‘nm’’).
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i. To use ‘‘pixel’’ as the unit, choose 1 for ‘‘Pixel calibration’’.

7. Press the ‘‘OK’’ button, three windows will appear:

a. ‘‘ImageTitle_data’’ – a file containing the image title and ‘‘_data’’ that will remain open and

store all measurements in a data frame containing the CytonemeID (‘‘ID’’), x and y position

of the base of the cytoneme (‘‘Xi’’ and ‘‘Yi’’), x and y position of the tip of the cytoneme

(‘‘Xf’’ and ‘‘Yf’’), calibrated time of the frame (‘‘Time’’), and length of the cytoneme (‘‘Length’’).

b. ‘‘CytonemeID’’ – this text window contains a random cytoneme ID number for the cytoneme

being measured. The first cytoneme ID number is preset.

c. ‘‘Measuring’’ – This window contains a brief explanation of options and an ‘‘OK’’ button

CRITICAL: Push ‘‘OK’’ only after cytoneme measurements are complete.

8. In the toolbar click the second button: ‘‘Cytoneme dynamics tool’’

9. Scroll through the time lapse image using the scroll bar and choose the initial time frame contain-

ing the cytoneme to be measured and ‘‘draw a line’’ over the cytoneme by clicking and holding in

the cytoneme base and dragging until the tip.

a. The user may want to zoom in the image to facilitate the drawing and analysis.

b. For cytonemes that are not extended at t = 0, click the spot where the cytoneme will start ex-

tending in the time frame immediately before the frame in which it appears.

CRITICAL: The accuracy of the traces is key for reliable measurements.

10. Once the mouse click is released, the next time frame will appear and the measured data will be

annotated in the data frame.

11. Repeat this until the cytoneme lengths have beenmeasured in all the time frames inwhich it appears.

12. After completing length measurements for a cytoneme, push the letter ‘‘c’’ on the keyboard and

a new random ‘‘CytonemeID’’ will appear.

13. Repeat steps 9–12 for as many cytonemes you desire to measure.

Note: The cytoneme order is not relevant in this analysis.

Note: Youmay use the ROIManager window to verify if a given cytoneme has beenmeasured.

14. With length measurements complete, push the button ‘‘OK’’ in the ‘‘Measuring’’ window. All

windows will close and the data frame file (Table 1) named with the ‘‘Group name’’ and ‘‘Sample

number’’ will be saved in the folder with the max intensity z-projection image.

CRITICAL: Maintain the name configuration for the data frame file.

15. MEASUREMENT ERROR CORRECTION: if a measurement was incorrect, select all lines of the

data frame with error and delete, then scroll back to the desired time point and resume

measuring.

16. UNWANTED CLOSE: if the ‘‘CytonemeID’’ is closed prematurely, the Cytoneme Analysis Tool is

stopped. To resume, push the key ‘‘c’’ on the keyboard and a new random ID will be generated.

Troubleshooting 7

Note: All the measurements made with the incomplete entered ID must be deleted because

the ID number will change for subsequent measurements. Delete all lines in the measure-

ments table for the cytoneme and repeat all measurements.

Data organization for processing

Timing: 5 min
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These instructions are for the downstream data processing using RStudio. Organize the files into

folders exactly as instructed below.

17. Create a folder with the experiment title (i.e.: ‘‘Drug test’’)

18. Inside this folder create one folder for each experimental group and label each folder with the

group name (i.e.: ‘‘Control’’, ‘‘Treatment1’’, ‘‘Treatment2’’, .)

19. Copy all data files generated with FIJI/ImageJ to the corresponding experimental group

CRITICAL: For optimal performance of the analysis routines, data sets must be organized

exactly as indicated in ‘‘17, 18, and 19’’.

Data processing in RStudio

Timing: 10 min

These steps will guide the user to analyze all the cytoneme data of single or multiple groups.

Note: For a complete video tutorial of the following steps, see Method.Video.S3 at README

page of the GitHub repository

20. Open the ‘‘Cytoneme_filipodia_dynamics_pipeline_ALLinONE’’ file in RStudio (Figure 4 – step

1).

21. Go to Session>Set Working Directory>Choose Directory.

22. Choose the experiment folder (i.e.: ‘‘Drug test’’) and click Open (Figure 4 – step 2).

23. List the desired group order for the graph analysis (Figure 4 – step 3).

a. The group name must match the folder’s name for each of the group

b. The names should be within quotation marks.

c. The names should be inside parentheses and followed by a comma.

d. Example: Group_order<- c("Control", "Treatment1", "Treatment2")

Note: FACTOR_STALL can be changed by replacing the number ‘‘0.5’’ by any number higher

than zero and smaller than 1. The product of FACTOR_STALL and the average of all step sizes

Table 1. Example of first 20 rows of raw data measured in ‘‘Wild type_Sample_1’’

ID Xi Yi Xf Yf Time Length

12928 215 256 215 256 8.4 0

12928 215 257 197 264 9.45 4.3899

12928 215 255 200 259 10.5 3.5461

12928 215 258 192 259 11.55 4.7736

12928 211 260 179 261 12.6 6.4472

12928 215 259 173 260 13.65 8.4008

12928 211 260 173 261 14.7 7.7571

12928 210 260 183 261 15.75 5.6175

12928 212 262 193 262 16.8 4.0604

12928 209 260 209 260 17.85 0

10461 207 247 207 247 11.55 0

10461 206 251 203 254 12.6 1.1934

10461 205 249 190 266 13.65 5.6657

10461 204 251 183 280 14.7 9.0129

10461 204 251 184 287 15.75 9.8568

10461 206 253 190 278 16.8 7.2228

10461 205 257 199 265 17.85 2.4351

10461 205 256 204 257 18.9 0.3978

27596 237 276 237 276 1.05 0
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for a given cytoneme defines the limit of a step to be considered STALLING (i.e.: if the FAC-

TOR_STALL is 0.5 and the average step size is 2 mm, then any step below 1 mm will be consid-

ered stalling) (Figure 4 – step 4).

24. Push the button ‘‘Source’’ (Figure 4 – step 5). Troubleshooting 8

Expected outcomes

This R script will process the data of each cytoneme in each sample of all groups. It will process the

difference in length from one time point to the next (called ‘‘step’’) and from this information will

compute a list of parameters for each cytoneme in a sample that is stored in the file

‘‘Cyt_Para_GroupName_SampleX’’:

Genotype – Group same

Sample – Sample Name

CytonemeID – randomized ID number for each cytoneme

Average_stepsize – the length average of all steps for a cytoneme

Ave_FWD_stepsize - the length average of all forward steps for a cytoneme

Ave_REV_stepsize - the length average of all reverse steps for a cytoneme

Total_Displacement- total displacement by the tip of the cytoneme

Figure 4. Data processing and graph plotting using R/R Studios

Open ‘‘Cytoneme_filipodia_dynamics_pipeline_ALLinONE’’ file downloaded from the GitHub repository (step 1).

Choose the file directory that contains the data sets acquired in FIJI and organized in folders by group, Session>Set

Working Directory>Choose Directory. (step 2). Indicate the groups in order of preference for analysis (step 3), if

desired adjust the STALL_FACTOR (step 4) and click the Source button (step 5).
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Displa_FWD - total displacement of forward direction by the tip of the cytoneme

Displa_REV - total displacement of reverse direction by the tip of the cytoneme

Displa_STALL - total displacement during stall by the tip of the cytoneme

Max_length – max length reached by each cytoneme

Stall_time – time spend in stall

Average_stall_speed – average speed in stall

Average_Speed – average speed of the whole movement of each cytoneme

FWD_Speed - average speed in forward

REV_Speed - average speed reverse

Lifetime – time of cytoneme persistence

After computing these parameters for each sample, a correlation plot between all numerical parameters

is generated with the label ‘‘CorPlot_GroupName_SampleX’’ for each sample and for the group

‘‘CorPlot_combined_GroupName’’ (Figure 5B), then the cytoneme parameter files of all samples are

combined into a single file ‘‘Cyt_Para_combined_GroupName’’. A file named ‘‘Cyt_Stats_GroupName_

SampleX’’ contains descriptive statistics for each parameter (mean, median, standard deviation) of each

sample in the group and a file ‘‘Cyt_Stats_combined_GroupName’’ with the descriptive statistics for all

samples combined in the group. Finally, six graphs are generated showing (1) length variation, (2) step

size, and (3) status (forward, stall or reverse) for each cytoneme in relation to the time each cytoneme

is active, and ‘‘RelativeTime’’ graphs (4) length variation (Figure 5C), (5) step size (Figure 5D), and (6) status

(Figure 5E) plotted with starting points for all cytonemes normalized to time = 0.

In the experiment folder (step 17), the file ‘‘Cyt_Para_combined_GroupName’’ for each group is saved

and all data for the groups are combined in the file ‘‘Combine_ALLgroups’’. Several plots are generated

in the folder ‘‘Graphs’’: dispersion plots of all numerical parameters compared to lifetime (Figure 5F), and

total displacement and violin plots comparing all groups for each parameter (Figures 5G and 5H).

Optional: The data in ‘‘Combine_ALLgroups’’ can be pasted into the web app ‘‘SuperPlotOf-

Data’’ (https://huygens.science.uva.nl/SuperPlotsOfData/) for generation of plots comparing

the cytoneme parameters between groups and replicates (Goedhart, 2021).

LIMITATIONS

Whereas conditions have been described that support wing disc development for at least 16 h dur-

ing ex vivo culture (Aldaz et al., 2010), the method presented here for the wing disc-associated ASP

supports ASP development for only 4–5 h. Nevertheless, the culture conditions represent a signifi-

cant improvement over previous methods. Imaging is limited by the small diameter of cytonemes

(�200 nm (Wood et al., 2021)) that requires bright fluorescent tags for detection with a confocal mi-

croscope and low laser intensity to minimize photobleaching and phototoxicity. Analysis of cyto-

neme lengths and dynamics must contend with the fact that cytonemes do not lie in a single optical

plane. The method presented here measures the cytoneme length in 2D max intensity projection. It

is semi-automated because fully automated analysis, such by FiloQuant (Jacquemet et al., 2017) or

Filopodyan (Urban�ci�c et al., 2017), is limited by the high density of cytonemes, the presence of
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overlapping cytonemes during extension and retraction cycles and presence of branching cyto-

nemes. AI approaches such as ones offered by ZeroCostDL4Mic (von Chamier et al., 2021), may

be useful.

TROUBLESHOOTING

Problem 1

The inner and outer 3D printed ring may not fit together if printing is not sufficiently precise.

Potential solution

This may be corrected by printing the rings again with higher resolution, or by slightly smoothing the

surface of the rings with a nail file. Caution is advised as the rings must fit tightly in order to stretch

the filter membrane.

Problem 2

Air in the trachea complicates placement of the wing disc with trachea facing down on the glass.

Potential solution

Flip the wing disc to the desired position and immediately reduce the media volume. Volume should

be small enough for surface tension to hold the tissue in place but not so small that the tissue dries.

Figure 5. ASP cytoneme dynamics analysis comparing wild-type sample and knockdown of brother-of-toutvelu in the apterous domain of the wing

disc

(A and B) Wild type ASP and one cytoneme extending and retracting cycle (A – scale bar: 20 mm). Correlation plot for all numerical parameters of

cytoneme movement in wild type sample (B).

(C–E) Length variation (C), step size variation (D) and movement status (forward, stall or reverse) (E) for each cytoneme represented in each line over time

(min). All initial time points are normalized to zero.

(F–H) Dispersion plot of total displacement (mm) over lifetime (min) for all cytonemes in wild type (yellow) and ApGAL4-botvRNAi (magenta) sample

groups (F). Violin plot for total displacement (G) and lifetime (H) of the cytonemes of wild type (yellow) and ApGAL4-botvRNAi (magenta) sample

groups.

All plots (B–H) were generated with data processing in RStudio on steps 20 to 24 in quantification and statistical analysis.

ll
OPEN ACCESS

12 STAR Protocols 3, 101138, March 18, 2022

Protocol



Problem 3

It is possible that during placement of the ring or the membrane on top of the sample, the wing

imaginal disc may flip or get twisted in the dish due to fluid movement.

Potential solution

Place more than one wing disc in the dish to increase the chance that a disc is in an optimal orien-

tation for imaging.

Problem 4

The ASP is sensitive to damage, photobleaching and phototoxicity.

Potential solution

Cell damagemay be caused bymishandling during dissection. Avoid touching or pinching the imag-

inal disc and ASP cells, or stretching the tissues. This is a critical part of the protocol. Practice, discard

any unhealthy sample, and repeat until successful.

Photobleaching and phototoxicity are common issues when imaging live samples with visible light.

The fluorescent tag must have high fluorescent yield so that low laser power is sufficient. Alterna-

tively, multi-photon confocal microscope imaging might reduce light exposure.

Problem 5

The cytonemes stalled during the time course. If the ASP is pushed against the glass, even by pres-

sure caused by the filter membrane, the cytonemes may adhere to the glass and not release. This

may also create the artifactual appearance of many cytoneme.

Potential solution

To distinguish this artifact from normal cytonemes, look for extension/retraction movements that

follow the curvature of the tissue and are not parallel to the glass. Be attentive during dissection

and mounting the sample. When placing the ring on top of the sample make the movement as

steady as possible. Avoid leaving the sample with minimal culture media by adding the 2 mL of me-

dia as soon as possible after placing the ring. If using the double-sided tape spacers, be careful when

placing the membrane, making sure it is stretched between the two spacers, and with the forceps

make sure the membrane attaches to the tape before adding the media. Add the 2 mL media care-

fully and slowly to avoid any pressure to the membrane or sideway ring movement.

Problem 6

There was no cell division during the time course.

Potential solution

Cell divisions in the ASP are infrequent and may not be observed in an imaging period of 4–5 h.

Problem 7

The data frame is a text editable window. It is possible that after attempting to delete a line the user

may place the text cursor in the wrong place.

Potential solution

When deleting a data line in the ‘‘_data’’ window, make sure to place the text cursor in the end (right

side of the length number) of the last measurement line. This will guarantee the following data point

will be annotated in the next line.

Problem 8

If the user attempts a RStudios analysis run by clicking ‘‘Source’’ but an error occurs (title or group or

order may be incorrect), some analysis files will be generated before the error stops the analysis.
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Potential solution

Delete all files generated inside the experiment folder and inside any group folder before re-running

the analysis in RStudios. Also repeat steps 22 and 23.

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Thomas B. Kornberg (Tom.Kornberg@ucsf.edu)

Materials availability

The inner and outer rings were designed on Onshape and the .stl files for 3D printing of are available

for download here: https://github.com/gbarbosabio/Culture_rings_3D.git

Data and code availability

The datasets/code generated during this study are available at GitHub: https://github.com/

gbarbosabio/Cytoneme_dynamics, as well as at Zenodo (Barbosa and Kornberg, 2021).

SUPPLEMENTAL INFORMATION

Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2022.101138.
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